Click here to buy the full 199-page "Take Control of Getting Started with DEVONthink 2, Second Edition" for only $15!
Table of Contents

Read Me First
   Updates and More .................................................................................................................. 5
   Basics .......................................................................................................................... 6
   What’s New in the Second Edition ...................................................................................... 8

Introduction

DEVONthink Quick Start

Quicker Start for First Edition Readers

Understand DEVONthink Basics
   What Exactly Is DEVONthink? .................................................................................................. 15
   Words You Should Know ......................................................................................................... 19
   Importing vs. Indexing ............................................................................................................ 22
   Organizing Features ................................................................................................................ 25
   DEVONthink Editions ............................................................................................................. 27
   What DEVONthink Is Not Good For ....................................................................................... 28

Explore DEVONthink’s Interface
   Assistant ............................................................................................................................. 30
   Main Window .......................................................................................................................... 32
   Panels .................................................................................................................................. 45
   Drawers .................................................................................................................................. 50
   Document Windows ............................................................................................................... 53
   Inboxes ................................................................................................................................. 54
   Workspaces .......................................................................................................................... 55

Set Up DEVONthink Databases
   Create a New Database .......................................................................................................... 56
   Configure Database Properties .............................................................................................. 59

Get Information into DEVONthink
   Decide Where Your Documents Will Go ................................................................................ 64
   Create Documents in DEVONthink ....................................................................................... 68
   Use the Import or Index Command ......................................................................................... 72

Click here to buy the full 199-page "Take Control of Getting Started with DEVONthink 2, Second Edition" for only $15!
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Drag and Drop</td>
<td>73</td>
</tr>
<tr>
<td>Use the System-Wide Global Inbox</td>
<td>74</td>
</tr>
<tr>
<td>Use the Services Menu</td>
<td>77</td>
</tr>
<tr>
<td>Use the Sorter</td>
<td>80</td>
</tr>
<tr>
<td>Use the Clip to DEVONthink Browser Extension</td>
<td>84</td>
</tr>
<tr>
<td>Grab Web Data with Bookmarklets</td>
<td>86</td>
</tr>
<tr>
<td>Add Email Messages</td>
<td>89</td>
</tr>
<tr>
<td>Use the PDF Menu</td>
<td>92</td>
</tr>
<tr>
<td>Scan Documents into DEVONthink</td>
<td>94</td>
</tr>
<tr>
<td>Use the Built-in Web Browser</td>
<td>102</td>
</tr>
<tr>
<td>Read RSS Feeds in DEVONthink</td>
<td>105</td>
</tr>
<tr>
<td>Joe’s Recommendations for Getting Stuff into DEVONthink</td>
<td>109</td>
</tr>
<tr>
<td>Organize Your Information</td>
<td></td>
</tr>
<tr>
<td>Understand Groups and Tags</td>
<td>112</td>
</tr>
<tr>
<td>Create and Use Groups</td>
<td>117</td>
</tr>
<tr>
<td>Tag Documents</td>
<td>125</td>
</tr>
<tr>
<td>Work with Links and WikiLinks</td>
<td>129</td>
</tr>
<tr>
<td>Move Data between Databases</td>
<td>132</td>
</tr>
<tr>
<td>Split and Merge Documents</td>
<td>133</td>
</tr>
<tr>
<td>Find Your Information</td>
<td></td>
</tr>
<tr>
<td>Perform a Simple Search</td>
<td>135</td>
</tr>
<tr>
<td>Refine a Search with Search Options</td>
<td>136</td>
</tr>
<tr>
<td>Use the Search Window</td>
<td>137</td>
</tr>
<tr>
<td>Use Smart Groups</td>
<td>139</td>
</tr>
<tr>
<td>Search Using the Concordance</td>
<td>142</td>
</tr>
<tr>
<td>Work with Your Information</td>
<td></td>
</tr>
<tr>
<td>Edit Documents in DEVONthink</td>
<td>144</td>
</tr>
<tr>
<td>Edit Images</td>
<td>146</td>
</tr>
<tr>
<td>Navigate PDFs</td>
<td>148</td>
</tr>
<tr>
<td>Annotate PDFs</td>
<td>150</td>
</tr>
<tr>
<td>Edit Documents in External Applications</td>
<td>153</td>
</tr>
<tr>
<td>Sync DEVONthink Databases between Macs</td>
<td></td>
</tr>
<tr>
<td>Understand Sync Basics</td>
<td>155</td>
</tr>
<tr>
<td>Choose a Sync Destination</td>
<td>156</td>
</tr>
</tbody>
</table>
Welcome to *Take Control of Getting Started with DEVONthink 2, Second Edition*, version 2.0, published in March 2012 by TidBITS Publishing Inc. This book was written by Joe Kissell and edited by Adam Engst (with help from Tonya Engst).

This book teaches you the basics of DEVONthink (Personal, Professional, and Pro Office editions) version 2.x. You’ll learn how to find your way around, get information into and out of DEVONthink, and make the most of the program’s most important features.

If you have an ebook version of this title, please note that if you want to share it with a friend, we ask that you do so as you would a physical book: “lend” it for a quick look, but ask your friend to buy a new copy to read it more carefully or to keep it for reference. Discounted classroom and Mac user group copies are also available.

Copyright © 2012, Joe Kissell. All rights reserved.

---

**Sponsored by DEVONtechnologies**

This book was sponsored by DEVONtechnologies. Special thanks to Eric Böhnisch-Volkmann for his enthusiasm for the project and to Christian Grunenberg for his clarifications about subtle features.

---

**Updates and More**

You can access extras related to this book on the Web (use the link in *Ebook Extras*, near the end; it’s available only to purchasers). On the ebook’s Take Control Extras page, you can:

- Download any available new version of the ebook for free, or buy any subsequent edition at a discount.

Click here to buy the full 199-page "Take Control of Getting Started with DEVONthink 2, Second Edition" for only $15!
• Download various formats, including PDF, EPUB, and—usually—Mobipocket. (Learn about reading this ebook on handheld devices at http://www.takecontrolbooks.com/device-advice.)

• Read postings to the ebook’s blog. These may include new tips or information, as well as links to author interviews. At the top of the blog, you can also see any update plans for the ebook.

• Get a discount when you order a print copy of the ebook.

If you bought this ebook from the Take Control Web site, it has been added to your account, where you can download it in other formats and access any future updates. However, if you bought this ebook elsewhere, you can add it to your account manually; see Ebook Extras.

Basics

In reading this book, you may get stuck if you don’t know certain fundamental facts about using your Mac or if you don’t understand Take Control syntax for things like working with menus or finding items in the Finder. Please note the following:

• **Menus:** Where I describe choosing a command from a menu in the menu bar, I use an abbreviated description. For example, the abbreviated description for the menu command that copies data in DEVONthink is “Edit > Copy.”

  **Note:** The application menu (the one by the Apple  menu; it has the name of the currently active application) has a different name depending on your edition of DEVONthink. For convenience, I refer to this menu using the term DEVONthink. The menu name may be different for you (if I say, “choose DEVONthink > Preferences,” you may have to choose DEVONthink Pro Office > Preferences).

• **Finding an application’s preferences:** I often refer to preferences in an application that you may want to adjust. Don’t confuse an application’s preferences with the system-wide settings found in System Preferences. To access the preferences for an application, choose *Application Name* > Preferences. For example, in DEVONthink Pro, you would choose DEVONthink Pro > Preferences.
• **Path syntax:** This book occasionally uses a *path* to show the location of a file or folder in your file system. For example, Mac OS X stores most utilities, such as Terminal, in the Utilities folder. The path to Terminal is: `Applications/Utilities/Terminal`.

The slash at the beginning of the path tells you to begin from the root level of the disk. You will also encounter paths that begin with ~ (tilde), which is a shortcut for the current user’s home folder. For example, if the person currently logged in has the user name `joe` and wants to install fonts that only he can access, he would install the fonts in his `~/Library/Fonts` folder, which is just another way of writing `/Users/joe/Library/Fonts`.

• **User Library:** The library folder mentioned in the previous paragraph, `~/Library`, is normally invisible in Lion. To see it, hold down the Option key and choose Go > Library in the Finder.

• **Right-clicking (Control-clicking):** Some actions in DEVONthink are accomplished by pointing at an item, performing a *secondary click* (or tap) on your mouse, trackball, or trackpad, and then choosing a command from a contextual pop-up menu. (In some cases, this contextual menu is, in fact, the *only* way to perform a given command!)

The original (and still functional) way to perform a secondary click on a Mac is to hold down the Control key while clicking—that is, to Control-click. A multi-button input device (including an Apple Magic Mouse or Mighty Mouse) can be configured so that pressing on one side (or button) produces a standard click and pressing on the other produces a secondary click. Similarly, the Magic Trackpad and the built-in trackpads on Apple laptops can be configured to produce a secondary click in various ways, such as double-tapping.

In this book, I say “right-click (Control-click),” by which I mean “do whatever you have to do to display the contextual menu.” If you prefer a different method and your input device supports it, feel free to display the contextual menu in the way that seems best to you.
What’s New in the Second Edition

DEVONthink has been updated quite a few times since I wrote the first edition of this book, and even though the software is still “DEVONthink 2” (that is, version 2.x), the latest version as I write this text—version 2.3.3—includes hundreds of differences from version 2.0. (I am reliably informed that the next major update, version 2.5—due at some point in the first several months of 2012—will still closely match what this book describes.) In addition, since the first edition appeared, Apple released Mac OS X 10.7 Lion, which introduces its own long list of changes.

Accordingly, I’ve updated this book in many ways, both large and small.

Tip: If you already read the first edition of this book, take a glance at Quicker Start for First Edition Readers!

Among the most significant changes are the following:

• A new section about the Assistant, which provides tips and support tools. See Assistant.

• Information about the two forms of Full Screen mode (one of which is the Lion method). See Full Screen.

• A mention of the Activity panel, used during syncing. See Activity.

• An introduction to the new Workspaces feature, which lets you save windows, views, and other onscreen elements. See Workspaces.

• A sidebar explaining why Dropbox and local network servers aren’t good places to store your DEVONthink databases. See Where Not to Store Your Databases.

• Thoroughly revised guidance regarding groups and tags, now that “Exclude Groups from Tagging” is the default setting for new databases. See Configure Database Properties and Understand Groups and Tags.

• A tip about importing and deleting documents in one step. See the sidebar Import and Delete.
• Details about how the Sorter now interacts with Lion’s Full Screen mode. See Use the Sorter.

• Instructions on installing and working with the new DEVONthink extensions for Chrome, Firefox, and Safari. See Use the Clip to DEVONthink Browser Extension.

• Significantly revised instructions on using bookmarklets. See Grab Web Data with Bookmarklets.

• An expanded discussion about adding email messages, which now includes importing them from Microsoft Outlook and Entourage. See Add Email Messages, and especially Use the Outlook and Entourage AppleScripts.

• Coverage of DEVONthink’s new capability to communicate directly with many scanners and digital cameras. See Scan Documents into DEVONthink, and in particular Pull an Image from a Scanner or Camera.

• Information about using compound predicates in smart groups. See Use the Smart Group Editor.

• A new chapter about using the recently introduced capability to sync databases with other copies of DEVONthink, Dropbox, and other locations. See Sync DEVONthink Databases between Macs.

• A new chapter about DEVONthink To Go, an iOS app that lets you take your DEVONthink databases with you. See Use DEVONthink To Go.

• An appendix listing shortcuts involving the keyboard (with or without the mouse) that may not be obvious. See Appendix A: Keyboard Shortcuts.
Introduction

I almost don’t know where to begin. That’s my problem as an author, and it may be your problem as a user, too. DEVONthink is an information management tool with a marvelously deep, rich set of features, and it can adapt itself to just about any set of needs or work preferences. That’s the good news; the bad news is that this wealth of power is like a 50-page restaurant menu in which every dish sounds equally delicious. There are so many excellent choices that finding a clear strategy to make the most of the meal—or the software, as the case may be—can be a daunting prospect.

My goal in this book is to do just that: to help you wrap your brain around DEVONthink’s extensive options and figure out how best to use it to accomplish your goals. Whether you are starting out with the program for the first time or are a seasoned user looking for ways to get more out of it, I hope to show you where to focus, what to try, and how to think about DEVONthink in the most effective way.

DEVONthink already has plenty of good documentation in the form of built-in help files. The purpose of this book is neither to replace that information nor to explain the operation of every command and button. Rather than create an exhaustive reference guide, I’ve concentrated on the key tasks you’ll want to accomplish. After providing an overview of the program’s main concepts and interface, I walk you through the principal activities you’ll do over and over, such as getting information into DEVONthink; organizing, finding and working with that information within the program; and, finally, getting the information back out (exporting or sharing it).

Stepping Stones

I’ve peppered this book with a series of blue boxes like this one, which provide special advice for working through complex choices in DEVONthink. Think of them as stepping stones that help you navigate both the book and the software more easily.
**Note:** DEVONthink comes in Personal, Professional, and Pro Office editions. In this book, when I write “DEVONthink,” I’m referring to features in all three; where appropriate, I mention which edition(s) are missing any features I discuss. The current edition of this book assumes you have version 2.3 or later of one of these programs. If you have a *much* later version, it may include some capabilities or user interface changes I don’t cover here, but the basic facts should still be the same. See [DEVONthink Editions](#) for more details.

And if all that leaves you hungry for more, I also provide a bit of dessert—a chapter that goes a bit deeper into some of the program’s advanced capabilities.

Since the first edition of this book was published, DEVONthink has had 12 (and counting) updates, meaning DEVONtechnologies is constantly working on improving the software. It also means that since the time I wrote this second edition of this book (when DEVONthink version 2.3.3 was current, and the new sync and scan plugins were in public beta testing), any number of things may have changed—new features may have been added, bugs fixed, interface elements rearranged, and so on.

Unfortunately, we can’t update this book as frequently as the software, so you may occasionally encounter something in the book that doesn’t quite match with what you see on your screen. I don’t expect these small inconsistencies to cause you any problems, but I do recommend reading the release notes for each update of DEVONthink you install for details on what’s new. And be sure to access the online [Ebook Extras](#) for this ebook and check this book’s blog page from time to time to see if I’ve added any new information.
DEVONthink Quick Start

This book helps you find your way around DEVONthink and use its most important features effectively. Each chapter builds on the one before it, so I recommend reading the book sequentially. If you choose to jump around, please read at least the first two chapters—Understand DEVONthink Basics and Explore DEVONthink’s Interface—which will help you understand the rest of the material.

Get your bearings:
• If you’ve already spent time with the first edition of this ebook, read Quicker Start for First Edition Readers, ahead shortly.
• Acquaint yourself with DEVONthink’s unique conventions and terminology; see Understand DEVONthink Basics.
• Learn your way around and where to find essential features; see Explore DEVONthink’s Interface.
• Create one or more containers to hold your personal data; see Set Up DEVONthink Databases.

Put DEVONthink to work:
• Create new documents or import data from a variety of sources; see Get Information into DEVONthink.
• Group, label, and tag data; see Organize Your Information.
• Use simple or advanced techniques to locate data you’ve previously stored in DEVONthink; see Find Your Information.
• Edit data in DEVONthink or an external editor, and use OCR with scanned documents; see Work with Your Information.

Share your DEVONthink data:
• Consider your options in the sidebar Choosing a Sharing Strategy.
• Keep multiple copies of DEVONthink in sync; see Sync DEVONthink Databases between Macs.
• Store and manage your DEVONthink data on any iOS device; see Use DEVONthink To Go.

Click here to buy the full 199-page “Take Control of Getting Started with DEVONthink 2, Second Edition” for only $15!
• Share data over the Web or export it in numerous formats; see Get Information Out of DEVONthink.

Go beyond the basics:
• Learn about some advanced features; see Dig Deeper.
• Find a list of keyboard (and keyboard-plus-mouse) shortcuts; see Appendix A: Keyboard Shortcuts.
• Find resources for further exploration; see Learn More.
Quicker Start for First Edition Readers

Although much has changed in DEVONthink and Mac OS X over the past year or so, anyone who already read the first edition of this book should have a good grasp of the fundamentals and won’t need to re-read this entire edition—or even all the items listed in What’s New in the Second Edition, a few pages back. It will, however, be a more valuable reference guide since it now more closely matches reality, so the next time you dip into a feature you haven’t tried in a while, be sure to consult the relevant portion of the book.

If it’s been a long time since you first read this book, or if you haven’t paid careful attention to all the recent changes in DEVONthink and Mac OS X, I want to draw your attention to a few items in particular that are well worth a fresh look:

• Lion’s new Full Screen mode, which also has implications when you Use the Sorter
• Workspaces for saving and restoring windows and tabs
• A rethinking of how to Understand Groups and Tags
• Easier Web page importing when you Use the Clip to DEVONthink Browser Extension or Grab Web Data with Bookmarklets
• A new capability to Pull an Image from a Scanner or Camera
• For anyone with more than one Mac, a hugely valuable new feature that lets you Sync DEVONthink Databases between Macs
• For those with an iPhone, iPad, or iPod touch, the option to take your data with you when you Use DEVONthink To Go
• As you become more expert with DEVONthink, you may want to learn some of its less-obvious keyboard (and keyboard plus mouse) shortcuts. I list them in Appendix A: Keyboard Shortcuts.

Tip: I’ve added notes labeled New! in the spots listed above to help you more easily identify these essential changes.
DEVONthink Basics

DEVONthink isn’t difficult to use, but because it offers unique ways of dealing with your data, it requires you to learn a few new concepts and terms, and understand some behaviors that may be unexpected at first. Once you have a grip on the basic principles that underlie DEVONthink’s operation, you’ll find that its other features and capabilities fall into place more readily. Meanwhile, even though DEVONthink is both powerful and versatile, it’s not always the right tool for the job—so it’s also important to understand what it’s not ideal for and when to look for a different tool.

Watch Me First!
Before you do anything else, I recommend that you watch a 6-minute screencast included with DEVONthink. To do this, choose Help > Support Assistant, click the Welcome link at the bottom of the window, and then click the Click to Play button.

Once you’ve done that, I also suggest watching another brief (10-minute) screencast I created myself, which demonstrates a few key concepts in DEVONthink to help you better understand the material in this book. In particular, my screencast acquaints you with the notions of groups and tags, and shows you some ways that these two categorization techniques interact. To view the screencast, click this link: http://www.takecontrolbooks.com/resources/0095/dtintro.mov

What Exactly Is DEVONthink?
Because you’re reading this book, I assume you already have a copy of DEVONthink, and that in turn implies that you have at least some idea what it is. But as I discovered when surveying a variety of DEVONthink users, different people think of the program in very different ways. There’s no one right answer, but as you get to know DEVONthink, it may be helpful to understand what it is (and isn’t), how it can function, and how it differs from other comparable software.
Explore
DEVONthink’s Interface

Now that you know the basic concepts and terms that DEVONthink uses, it’s time to learn your way around. Because of the many ways DEVONthink can display your data and some of the unique tools it offers, you’ll be on a firmer footing if you take a few moments to read this chapter and learn how the interface is organized, where to find the things that you’ll use most often, and what some of the program’s icons and other controls do.

Assistant

The first time you launch DEVONthink, a window called the Assistant opens (Figure 1) to welcome you and offer tips, tutorials, support, and other help. The Assistant window will appear every time you launch DEVONthink. To keep it from doing so, deselect the Show This Window When DEVONthink Opens checkbox. (You can then display it manually, whenever you want, by choosing Help > Support Assistant.)

![Assistant Window]

Figure 1: The Assistant welcomes you with tips and tutorials.
Set Up DEVONthink Databases

Now that you know your way around DEVONthink, it’s time to create one or more databases and start collecting information. You can set up a database with just a few clicks, but you may also want to take some additional steps to customize (and perhaps even password-protect) your database.

Create a New Database

If you’re using DEVONthink Personal, the program automatically creates its database (it supports only one) when you first launch it. DEVONthink Professional and DEVONthink Pro Office prompt you to create a database when you open them for the first time, and for many people that single database is sufficient. But if you want to create an additional database, the process is simple. Follow these steps:


2. Enter a name for your database and choose a location (or accept the default location). If you’re tempted to choose your Dropbox or a local network server as your destination, please read the sidebar just ahead, Where Not to Store Your Databases, first!

3. If you want to keep the information in your DEVONthink database from being indexed by Spotlight, uncheck Create Spotlight Index. Doing so doesn’t prevent you from searching within DEVONthink, but it does prevent the contents of your DEVONthink database from appearing in system-wide Spotlight searches. (You might choose this option if your database contains sensitive data and you’re concerned that someone else with access to your computer might stumble on it while using Spotlight.)

4. Click Create.

DEVONthink creates a new, empty database.
Get Information into DEVONthink

Whether you’re starting from scratch with newly created data or importing content from existing files or Internet sources, DEVONthink offers many mechanisms for collecting information. In fact, the biggest problem you may have is deciding which method you should use to put a particular piece of information into your database. In this chapter, I discuss the major ways of adding data to DEVONthink, explain the situations each method is best for, and finish with my overall recommendations.

In case you’re wondering what kinds of documents you can put in DEVONthink, the answer is any kind at all! (If you want to keep DEVONthink from importing certain kinds of files, uncheck the relevant boxes in the Files section of the Import preference pane.) DEVONthink can index anything containing text, and it can display nearly any kind of text or graphics file, most audio and video files, and even documents from Microsoft Office and Apple’s iWork. Even if you import a document that DEVONthink can’t display, the document can stay in the database, and you can open it using another program (see Edit Documents in External Applications).

Decide Where Your Documents Will Go

As you use DEVONthink, you can put each document in a specific group, in a catch-all inbox—perhaps in any of several databases—or in the global Inbox. For the most part, you get to choose where documents go, although there are cases in which you may not have realized what your choice was, so the result may be confusing if you’re not familiar with DEVONthink’s system.

The general rule (to which there are a few exceptions) is that documents go in either of two places:

- Where you put them
- A default destination, which you can choose (within limits)
Organize Your Information

Once you’ve gotten into the habit of collecting data in DEVONthink, you may quickly discover that you have hundreds or even thousands of pieces of information. Although you could, if you wanted, simply keep everything in your inbox and then search for whatever you need, DEVONthink offers numerous ways of grouping, labeling, tagging, and otherwise organizing your information. Once you’ve shown DEVONthink how you prefer to have your information organized, you can also take advantage of its almost magical Auto-Classify feature. The better you organize your data in DEVONthink, the easier it is to find what you’re looking for and to see the connections between related items.

Understand Groups and Tags

Before I tell you how to group and tag documents, I want you to know a bit about how the two mechanisms operate. If you haven’t already done so, this would be a good time to check out my screencast covering groups and tags (click http://www.takecontrolbooks.com/resources/0095/dtintro.mov to view it).

New! The behavior of groups and tags has changed considerably since DEVONthink 2.0. See Quicker Start for First Edition Readers for a list of other major changes since the first edition of this book.

Groups and tags are two ways of categorizing documents. Conceptually, they follow different models: you put documents in groups (so a document normally exists in only one location), whereas you apply tags to documents (so a document can have any number of tags). Of course, DEVONthink’s use of replicants makes it possible for a single document to exist in more than one location, but tags let you apply multiple categories to a document more simply and directly.

Groups tend to work best for data that has a largely self-evident logical structure, whereas tags are generally more freeform and subjective—how you want to think of particular documents rather than what data they objectively contain.
Find Your Information

One of the biggest reasons to store your stuff in DEVONthink (as opposed to, say, the Finder) is its fast, smart, and flexible searching. This chapter describes the search options, from simple to complex. It also discusses the Concordance, a specialized way of searching based on the frequency with which words appear in your database.

Perform a Simple Search

Most searches in DEVONthink are simple and straightforward—and the process couldn’t be easier. Type your search term into the search field on the toolbar, and DEVONthink almost instantly returns matching documents from anywhere in the current database—with default settings, you need not even press Return (Figure 47).

Figure 47: Type a term in the search box at the upper right for a super-fast search.
Work with Your Information

DEVONthink isn’t only about storing, organizing, and finding information. It also contains a full set of tools for editing documents (ranging from plain and styled text to images) and for annotating PDFs—so you can do a great deal of useful work without leaving the program. And when you need to do editing that goes beyond DEVONthink’s capabilities, you can easily open a document in the external application of your choice. I discuss all these options in the next several pages.

Edit Documents in DEVONthink

Editing most documents is straightforward, but I must mention something up front that could confuse you if you aren’t expecting it: The fact that you can view a document in DEVONthink doesn’t necessarily mean you can edit it—or, in some cases, select text in it.

Because DEVONthink uses Mac OS X’s Quick Look technology, it can index and display any kind of media the Finder can—including graphics, audio, and video files, iWork and Microsoft Office documents, and others for which Apple or a third party has installed an appropriate plugin. However, although some of these files can be manipulated inside DEVONthink, others cannot. Table 1, ahead slightly, gives an overview of what you can and can’t do in various kinds of documents.

Just as when viewing documents, you can edit a document directly in an edit pane (for views that have them), or double-click it to open it in a separate window.

Either way, before you can make changes to a document, it must be in a writable (as opposed to read-only) state and display an unlocked icon. If you see a read-only icon on the navigation bar, you must choose View > Text Alternative (Command-Option-P) or click the Text View/Preview button to switch to Text View in order to edit the document (as explained in the sidebar after Table 1).

Click here to buy the full 199-page "Take Control of Getting Started with DEVONthink 2, Second Edition" for only $15!
Sync DEVONthink Databases between Macs

Until very recently, trying to use the same DEVONthink database on two (or more) Macs was an exercise in frustration, because no built-in sync capability existed, and the various workarounds users came up with had significant limitations—sometimes serious enough to result in data loss.

But now, at last, those dark days are (mostly) behind us. If you have more than one Mac and want to make sure DEVONthink reflects the same content on all of them, regardless of where you add or change information, you can. (If you have only one Mac, this feature won’t help you, so feel free to skip ahead to the next chapter.)

Starting in March 2012, the sync capability is available to users of DEVONthink 2.3.3 or higher who have installed the DEVONthink Sync plugin, available in a public beta test version as a separate (free) download from http://www.devontechnologies.com/redirect.php?id=blog. (At publication time, the public beta hadn’t shipped yet, but we expect it to be available imminently.) Once beta testing is complete, DEVONtechnologies plans to include syncing as a built-in feature of DEVONthink version 2.5 and later—meaning no extra plugin will be required.

This book is being published before the public beta test is finished, and the sync feature is likely to change somewhat before it’s finalized. Therefore, in this chapter I provide only an overview of this new feature and omit specific, step-by-step details. Instead, I plan to create a screencast that will walk you through the entire process. I’ll make that available at some point after DEVONthink version 2.5 has shipped; when the time comes, you can find a link to the video on the book’s blog page (use the link in Ebook Extras, near the end of this ebook; it’s available only to purchasers).

Tip: If your goal in syncing DEVONthink data between two Macs is less about having the data on two Macs and more about giving another person access to the data, see the sidebar later in this chapter, Choosing a Sharing Strategy, for tips on different methods of making your DEVONthink data available elsewhere.
Use DEVONthink To Go

If you have an iPhone, iPad, or iPod touch, you can now take your DEVONthink data with you and work with it when you’re away from your Mac. To do this, you’ll need an iOS app called DEVONthink To Go, which costs $14.99.

Although DEVONthink To Go doesn’t have nearly the range of features that the desktop versions of DEVONthink do, it does let you view and search most documents, and even add and edit certain kinds of data directly on your iOS device.

If you have no iOS device, or if you’re not interested in taking your DEVONthink data with you, there’s nothing to see here—move on to the next chapter. Otherwise, keep reading to learn about using this extremely handy tool.

New! DEVONthink To Go is a major new product that became available after the first edition of this book was published. For other items you should notice if you read the first edition of this book, see Quicker Start for First Edition Readers.

Set Up the Mobile Sync Group

Although you can perform some basic tasks with DEVONthink To Go all by itself, its main value is in giving you access to the documents in the DEVONthink database(s) on your Mac. Thus, the first thing you should do is specify which items from each database you want to sync with your iOS device.

At your option, DEVONthink To Go will sync either or both of the following:

- Everything in your global Inbox (for DEVONthink Professional and DEVONthink Pro Office only)
- Everything (including replicants) in the Mobile Sync group, which appears at the top level of each database
Get Information Out of DEVONthink

Ordinarily, you’ll interact with the data in your DEVONthink database using DEVONthink itself. However, in some cases you may want to give others (on your local network or around the world) live access to your information—or make your DEVONthink database available to yourself when you’re using another computer. DEVONthink Pro Office’s built-in Web server lets you do just that. And, if the need arises, you can export static information from DEVONthink in a dizzying array of formats to suit almost any need.

**Tip:** If you’re setting up a DEVONthink-based Web server in order to share your data with others, read the sidebar Choosing a Sharing Strategy, earlier, to make sure you are aware of your sharing options, just in case one of the others is a better match for your needs.

Use DEVONthink’s Web Server

DEVONthink Pro Office has a built-in Web server that lets you share your database live over the Web. This is useful for giving yourself (or other family members) access to your data from other computers in your home, or for running an internal Web site that provides shared information for all the employees of a small company. It also makes it possible to add new information to your database from a Web browser.

**Note:** Web sharing exists only in DEVONthink Pro Office, not in DEVONthink Professional or DEVONthink Personal.

I want to emphasize, though, that this is not a full-blown database server, and it’s not suitable for running a public Web site. Compared to stand-alone servers, DEVONthink lacks many standard security, logging, performance, and customization features. So it’s good at what it does—but just bear in mind that what it does is intentionally limited.
Dig Deeper

So far, I’ve only scratched the surface of DEVONthink’s vast array of capabilities. Although I can’t cover every last feature, I want to wrap up this book with a brief discussion of a few key features that are a bit more obscure or advanced than what the average user may need on a daily basis. I hope you’ll use this information as a starting point to explore and experiment with the application on your own.

Maintain Your Databases

In certain situations, your DEVONthink databases can become corrupted. For example, if a system process DEVONthink depends on crashes while data is being written, the files may not be stored correctly or completely. Disk errors and other random events having nothing to do specifically with DEVONthink can also cause problems with your databases. If you begin noticing problems—weird error messages, missing documents, groups, or tags, or anything else that’s out of whack—you can use any of several techniques to fix them. (And, it doesn’t hurt to use these from time to time as a preventive measure, even if you haven’t noticed any problems.)

Verify & Repair

The Tools > Verify & Repair command checks the selected database for errors, and if it finds any, it fixes those it can. So choosing this command is a quick and easy way to solve many common problems.

During the repair process, if DEVONthink finds any files in its package on disk that don’t have corresponding entries in your database, it (re)imports them and puts them in a new group, at the top level of your database, called Orphaned Files. You can then move these newly adopted documents to the group(s) of your choice.

Backup & Optimize

You can configure DEVONthink to automatically back up and optimize its database periodically in the Backup preference pane. (When it does so, it backs up only the files containing metadata and indexes, not the documents themselves, which are more usefully backed up using Time Machine or your favorite backup utility.) However, regardless of that
Appendix A: Keyboard Shortcuts

Many of DEVONthink’s menu commands have corresponding keyboard shortcuts, and you can see those easily enough by looking at the menus. However, some keyboard shortcuts—particularly those involving a combination of keyboard and mouse—aren’t apparent from looking at the screen. In addition, DEVONthink adds a number of menu commands to locations outside the DEVONthink application itself, and although you can see those on the relevant menus, you may not think to look for them. So, in this brief appendix I’ve compiled a list of all the non-obvious DEVONthink keyboard (and keyboard-plus-mouse) shortcuts.

Keyboard-and-Mouse Combinations

The following shortcuts within DEVONthink occur with a combination of keyboard and mouse usage:

- **Duplicate to another location**: Option-drag.
- **Replicate to another location**: Command-Option-drag.
- **Create compound predicate (Smart Group or Advanced Search)**: Option-click the plus button to the right of any criterion, which then becomes an ellipsis button.
- **Select a rectangular region of text in a PDF**: With the Text tool selected, Option-drag.
- **Display a contextual menu**: Right-click (Control-click).
- **Resize all columns in Column View**: Option-drag any column divider.
- **Select multiple contiguous documents, groups, tags, etc.**: Shift-click.
- **Select multiple discontiguous documents, groups, tags, etc.**: Command-click.
Learn More

You can learn more about DEVONthink by consulting any of the following resources:

- **DEVONthink User Manuals**: The official PDF documentation from DEVONtechnologies covers other features that didn’t fit into this book.  

- **DEVONtechnologies User Forum**: Share your tips and experiences with other DEVONthink users, get problem-solving advice, and learn new ways to accomplish tasks in the User Forum.  

- **The Balcony**: To keep up with news about DEVONtechnologies, its products, and more, read Devonian Times, a blog by company president Eric Böhnisch-Volkmann.  
  [http://blog.devontechnologies.com/](http://blog.devontechnologies.com/)
About This Book

Thank you for purchasing this Take Control book. We hope you find it both useful and enjoyable to read. We welcome your comments at tc-comments@tidbits.com.

Ebook Extras

You can access extras related to this ebook on the Web. Once you’re on the ebook’s Take Control Extras page, you can:

• Download any available new version of the ebook for free, or buy a subsequent edition at a discount.

• Download various formats, including PDF, EPUB, and—usually—Mobipocket. (Learn about reading this ebook on handheld devices at http://www.takecontrolbooks.com/device-advice.)

• Read postings to the ebook’s blog. These may include new information and tips, as well as links to author interviews. At the top of the blog, you can also see any update plans for the ebook.

• Get a discount when you order a print copy of the ebook.

If you bought this ebook from the Take Control Web site, it has been automatically added to your account, where you can download it in other formats and access any future updates. However, if you bought this ebook elsewhere, you can add it to your account manually:

• If you already have a Take Control account, log in to your account, and then click the “access extras...” link above.

• If you don’t have a Take Control account, first make one by following the directions that appear when you click the “access extras...” link above. Then, once you are logged in to your new account, add your ebook by clicking the “access extras...” link a second time.

Note: If you try the directions above and find that the device you’re reading on is incompatible with the Take Control Web site, contact us at tc-comments@tidbits.com.
About the Author

Joe Kissell is Senior Editor of *TidBITS*, a Web site and email newsletter about Apple and the Internet, and the author of numerous books about Macintosh software, including *Take Control of Backing Up Your Mac* and *Take Control of iCloud*. He is also a Senior Contributor to *Macworld*, was the winner of a 2009 Neal award for Best How-to Article, and has appeared on the MacTech 25 list since 2007. Joe has worked in the Mac software industry since the early 1990s, including positions managing software development for Nisus Software and Kensington Technology Group.

In his increasingly imaginary spare time, Joe likes to travel, cook, and practice t’ai chi. He lives in Paris with his wife, Morgen Jahnke, their son, Soren, and their cat, Zora. To contact Joe about this book, send him email at jwk@me.com and include *Take Control of Getting Started with DEVONthink 2* in the subject of your message so his spam filters won’t intercept it.

Author’s Acknowledgements

Many people contributed to this book, and I greatly appreciate all the assistance. Special thanks are due to DEVONtechnologies president Eric Böhnisch-Volkmann for all his efforts in bringing this book about, and to my editor, Adam Engst. I also want to extend my thanks to the many DEVONthink users who contributed details about how they use the product—including Matthew Bookspan, Eben Bruyns, Laurence Chen, Cynthia Cheney, Nicole Dornseif, Clemens Fischmeister, Jack Forbusch, Keene Haywood, Andy Howell, Asaf Keller, Anthony Brettell Lodge, Chris Nidel, Basil Rolandsen, Alan Shutko, George R. Silverman, Jan Stoltenhoff, Christian Tagsold, Bruce Williamson, and Christoph W. Zimmermann.

Click here to buy the full 199-page "Take Control of Getting Started with DEVONthink 2, Second Edition" for only $15!
Shameless Plug

Although I write about computers as my day job, I have a great many other interests, which I write about on several Web sites, including Interesting Thing of the Day (http://itotd.com/) and my personal blog. You can find links to all my sites, a complete list of my publications, and more at JoeKissell.com. Or follow me on Twitter (@joekissell).

About the Publisher

Publishers Adam and Tonya Engst have been creating Apple-related content since they started the online newsletter TidBITS, in 1990. In TidBITS, you can find the latest Apple news, plus read reviews, opinions, and more (http://tidbits.com/). Adam and Tonya are known in the Apple world as writers, editors, and speakers. They are also parents to Tristan, who thinks ebooks about clipper ships and castles would be cool.

Production credits:
• Take Control logo: Jeff Tolbert
• Cover design: Jon Hersh
• Production Assistants: Michael E. Cohen, Oliver Habicht
• Editor in Chief, extra editor: Tonya Engst
• Publisher, editor: Adam Engst

Thanks to the many DEVONthink users who contributed to this book and to the folks at DEVONtechnologies, especially Eric Böhnisch-Volkmann, Christian Grunenberg, and Rob Rix.
Take Control of Getting Started with DEVONthink 2, Second Edition
Copyright © 2012, Joe Kissell. All rights reserved.

TidBITS Publishing Inc.
50 Hickory Road
Ithaca, NY 14850 USA
http://www.takecontrolbooks.com/

Take Control electronic books help readers regain a measure of control in an oftentimes out-of-control universe. Take Control ebooks also streamline the publication process so that information about quickly changing technical topics can be published while it’s still relevant and accurate.

This electronic book doesn’t use copy protection because copy protection makes life harder for everyone. So we ask a favor of our readers. If you want to share your copy of this ebook with a friend, please do so as you would a physical book, meaning that if your friend uses it regularly, he or she should buy a copy. Your support makes it possible for future Take Control ebooks to hit the Internet long before you’d find the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any free updates that become available.

Although the author and TidBITS Publishing Inc. have made a reasonable effort to ensure the accuracy of the information herein, they assume no responsibility for errors or omissions. The information in this ebook is distributed “As Is,” without warranty of any kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person or entity for any special, indirect, incidental, or consequential damages, including without limitation lost revenues or lost profits, that may result (or that are alleged to result) from the use of these materials. In other words, use this information at your own risk.

Many of the designations used to distinguish products and services are claimed as trademarks or service marks. Any trademarks, service marks, product names, or named features that appear in this title are assumed to be the property of their respective owners. All product names and services are used in an editorial fashion only, with no intention of infringement of the trademark. No such use, or the use of any trade name, is meant to convey endorsement or other affiliation with this title.

This title is an independent publication and has not been authorized, sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses terms that are the trademarks or the registered trademarks of Apple Inc.; to view a complete list of the trademarks and of the registered trademarks of Apple Inc., you can visit http://www.apple.com/legal/trademark/appletmlist.html.

Click here to buy the full 199-page "Take Control of Getting Started with DEVONthink 2, Second Edition" for only $15!
Featured Titles
Click any book title below or visit our Web catalog to add more ebooks to your Take Control collection!

*Take Control of Backing Up Your Mac* (Joe Kissell): Set up a rock-solid backup strategy so that you can restore quickly and completely, no matter what catastrophe arises.

*Take Control of Mail on the iPad, iPhone, and iPod touch* (Joe Kissell): Develop your mobile email strategy and learn how to use email effectively on your handheld Apple devices.

*Take Control of PDFpen 5* (Michael E. Cohen): Learn to create, edit, and manipulate PDFs with Smile’s PDFpen 5!

*Take Control of Scrivener 2* (Kirk McElhearn): Write your screenplay, novel, or dissertation with the author-focused features in Scrivener!

*Take Control of Speeding Up Your Mac* (Joe Kissell): Put the zip back into your Mac with advice based on Joe’s extensive research and experimentation in the area of Mac performance.

*Take Control of Spotlight for Finding Anything on Your Mac* (Sharon Zardetto): Whether by mouse or menu, or by typing a complex query, you’ll learn how to find your files, contacts, images, and much more.

*Take Control of Upgrading to Lion* (Joe Kissell): Find friendly advice that prepares you for a successful installation of Mac OS X 10.7 Lion, plus learn how to best run the installer while avoiding problems.

*Take Control of Using Lion* (Matt Neuburg): Learn to use 10.7 Lion effectively, whether you embrace all of Lion’s new features or strike a balance between old and new.

*Take Control of Your iPad* (Tonya Engst): Optimize your iPad experience—make important customizations, sync media and data, and get tips on making the most of core iPad apps.

*Take Control of Your Paperless Office* (Joe Kissell): With your Mac, scanner, and this ebook in hand, you’ll finally clear the chaos of an office overflowing with paper.

Click here to buy the full 199-page “Take Control of Getting Started with DEVONthink 2, Second Edition” for only $15!